Question Bank of Class – 5 Computer Science
Half Yearly Portion
Chapter – 1, Evolution of computers
A. Fill in the blanks.
1. The first mechanical calculating device was ________
2. __________ invented the first automatic sequence controlled calculator – Mark I.
3. Analytical engine was invented in __________
4. The first general purpose electronic computer was __________
5. __________ introduced the first microprocessor in 1971 for Intel.
(Ans. - 1. Abacus, 2. Howard Aiken, 3. Charles Babbage, 4. ENIAC, 5. Ted Holf)
B. State True of False.
1. EDSAC was the first computer to handle both numeric and text data.
2. Charles Babbage invented the Difference engine in 1822.
3. The first generation computers used transistors technology.
4. Tabulating machine was invented by J. Presper Eckart.
5. George Boole designed the Boolean logic.
(Ans. – 1. False, 2. True, 3. False, 4. False, 5. True)
C. Match the followings.
Column - A
1. Lady Augusta Lovelace
2. Second generation computer
3. Blaise Pascal
4. Third generation computers
(Ans. 1 = b, 2 = d, 3 = a, 4 = c)

Column - B
a. Pascaline
b. The first programmer
c. Integrated Circuits
d. Transistors

D. Application based questions.
1. Raman is preparing for a quiz which is based on the generation of computers. He is looking
for the input device used in the third generation. Can you provide him the answer?
2. Ruby is preparing a presentation on the main technology used by the different generation of
computers. She has forgotten the main technology used in the second generation of
computers. Suggest her the right answer.
(Ans. – 1. Keyboard, 2 – Transistors)
E. Multiple choice questions.
1. ____________ generation computers are based on Artificial Intelligence.
a. Fourth
b. Fifth
c. Second

2. Name the first machine that used the interchangeable punched cards to obtain the design
pattern on the clothes.
a. Jacquard‟s Loom
b. Difference Engine
c. Tabulating Machine
3. ____________ refers to the degree of perfection of operations performed by a computer.
a. Accuracy
b. Speed
c. robustness
4. __________ language was used in the first generation of computers.
a. Cobol
b. machine
c. Fortran
(Ans. 1 = b, 2 = c, 3 = a, 4 = b)
F. Answer the followings.
1. Write any two characteristics of computer.
Ans. Speed, accuracy, reliability, versatility, diligence, multi tasking and storage are the
characteristics of a computer.
2. State the difference between second and third generation computers.
Ans. Second generation computers – Transistors was the main technology used in these
computers. Magnetic tapes were used for storage. Punched cards were used as input devices.
Third generation computers - Integrated circuits (ic) were the main technology used in these
computers. Magnetic disks were used for storage, Keyboard was used as input device.
3. Write a short note on the device – Abacus.
Ans. Abacus was the first mechanical device for calculation developed in China. It was made up
of wooden frame with rods, each having beads. It was used for addition, subtraction,
multiplication and division.
4. Mention any two limitations of computer.
Ans. Incapability to think, no intelligence and dependence on power are the limitations of
computer.
Chapter – 2, Types of software
A. Fill in the blanks.
1. Software is of two types, ____________ and ____________
2. _________ controls the overall activity of a computer
3. An operating system manages all ___________ and __________ devices.
4. ___________ programs perform specific tasks, usually related to managing a computer, its
devices or its programs.
5. The presentation software is used to present an ________ or __________
6. _________ occurs when hard disk does not find contiguous memory to store large files.
(Ans. 1 – System and Application, 2 – Operating System, 3 – input and output, 4 – utility, 5 –
idea or concept, 6 – fragmentation)
B. State True or False
1. Application software can run without the presence of system software.

2. Disk Fragmentation runs on the scheduled basis.
3. Backup is a process of shrinking the files on a disk.
4. VisiCalc was the first computer spreadsheet program.
5. An interpreter translates the whole program into equivalent code, in one go.
(Ans. 1 = False, 2 = True, 3 = False, 4 = True, 5 = False)
C. Application based questions.
1. Radhika wants to protect her computer system against virus attacks. Which software will you
suggest her to install?
2. Surabhi has made a project on water pollution. She wants to mail it to her sister for further
improvement, but it does not upload due to its over size, which utility program will you
suggest her for this task?
3. Monika is a designer in a publishing house where books, brochures, and advertisements are
created. Which type of software does she need?
(Ans. 1- Anti Virus software, 2 – Compression software like WinZip, 3 – Desktop Publishing
Software)
D. Multiple choice questions
1. Which of the following utilities checks the connectivity and configuration of network devices.
a. Devices
b. Network Utilities
c. File Manager
2. _______ operating system allows a user to run more than one application programs at the
same time.
a. Multitasking
b. Multi-user
c. Multipurpose
3. A ________ program helps you to perform calculations and analyse data in a better way.
a. Spreadsheet
b. Word Processor
c. DTP
4. ________ is an example of Anti-virus utility.
a. Norton
b. WinZip
c. Both a and b
5. Software which are designed to meet the specific needs of users, are called _________
software.
a. Specific purpose
b. General purpose
c. System
6. The process of consolidating and rearranging data into one contiguous area, is called _____
a. Fragmentation
b. Defragmentation
c. None of these
(Ans. 1=b, 2=a, 3=a, 4=a, 5=a, 6=b)
E. Answer the followings.
1. Define the term Software. Name its types.
Ans. Software is the collection of programs that are stored and run on the computer
hardware and help users to work on the computer. It is of two types. They are – System
Software and Application Software.
2. What is an Operating System? Briefly explain any of its two functions.

3.

4.

5.

6.

Ans. An operating system is a type of system software that controls the overall activities of a
computer. It is needed to operate a computer. Two of its functions are –
Device management – an O/S controls the working of all input and output devices.
Running Software – an O/S runs the application software like Paint, MS Word, etc.
Explain the term Utility software.
Ans. Utility Software performs specific tasks related to managing a computer, its devices or
its programs. These programs help in the smooth functioning of the computer and to
perform better.
What is the function of Word processing software?
Ans. Word processing software helps us to create professional looking documents quickly
and efficiently.
What is the use of Scanning utility?
Ans. It provides protection to a computer against virus attack. It includes tools to recover lost
files and protect a computer from system failure.
State the difference between multi-user and multitasking system.
Ans. A multi-user operating system allows multiple users on different computers to access a
system at the same time through a network whereas a multitasking operating system allows
a user to run more than one application program on a computer at the same time.

Chapter – 3, Advanced features of Word Processor – I
A. Fill in the blanks.
1. The default margins are set at ________ from top, bottom, left and right edge of the page.
2. To copy formatting to multiple text, _______ on the Format Painter button.
3. Column breaks option is present on the ______ tab.
4. __________ refer to the amount of blank space between the edge of the page and the
document text.
5. The default tab stops are set at every ________
(Ans.- 1. 1 inch, 2. double click, 3. Page Layout, 4. Margins, 5. 0.5 inch)
B. State True or False.
1. Indentation determines the amount of spacing above or below a paragraph.
2. Tab key is used to move the cursor at certain spaces in a document.
3. The Page Break option splits the document into two or more columns.
4. Landscape is the default paper orientation in Word 2010.
5. The Subscript option places the selected text slightly above the baseline.
(Ans. 1=False, 2=True, 3=False, 4=False, 5=False)
C. Application based questions.

1. Aaryan has been given an assignment to write three paragraphs on the topic „Keep your city
clean‟. Help him to format the document by setting the indents and margins of the
paragraph. Name the options which he would use to format these.
2. Diya has created a Science project of 5 pages in Word 2010. Her Science teacher has
asked her to mention the topic, page numbers and her name in all the pages. Suggest her
the most suitable option for the same.
(Ans. 1. By using Ruler bars and by using Page Layout tab. 2. Header and Footer option)
D. Multiple choice questions.
1. The __________ option places the selected text slightly above the baseline.
a. Superscript
b. Subscript
c. Shadow
2. ___________ option divides a document in two or more columns.
a. Tab
b. Columns
c. Header
3. The selected text can be shifted ½ inch away from the left margin by using the _________
button.
a. Decrease Indent
b. Increase Indent
c. Spacing
4. The top and bottom margins of a document can be changed by using the _________
a. Vertical ruler
b. Horizontal ruler
c. Tab Stop
5. Which among the following shortcut keys is used to increase the indent?
a. Ctrl+N
b. Ctrl+M
c. Ctrl+D
(Ans. 1=a, 2=b, 3=b, 4=a, 5=b)
E. Answer the followings.
1. How will you apply formatting to another selection?
Ans. select the text whose formatting is to be copied. Click on the Format Painter button.
Drag the brush over the text to apply the formatting.
2. Why do we use Header and Footer options
Ans. Header and footer is used to apply some information on the top and at the bottom of
every page respectively.
3. What is indentation? List the types of indentation.
Ans. Indentation determines the amount of spacing between the text and the page margins.
It is used to move a paragraph or its first line to a specific position from the left or right
margin. Indentation can be of following types – first line indent, left indent, right indent or
hanging indent.
4. What are Page margins? What are the default settings of Left and Right margins?
Ans. Page Margin refers to the amount of blank space between the edge of the page and
the document text. The default setting of left and right margins are 1 inch from left and right
edge of paper.
Chapter – 4, Advanced features of Word Processor – II

A. Fill in the blanks.
1. The ___________ key is used to maintain the height and width of a shape.
2. ________ is a gallery of pre-designed pictures that can be inserted directly in a document.
3. Lines, Basic Shapes, Block Arrows are the options of __________ button.
4. The _________ feature is used to create special text effects.
5. A __________ is a placeholder where text can be entered.
(Ans. 1. Shift, 2. Clip Art, 3. Shapes, 4. WordArt, 5. Text box)
B.
1.
2.
3.
4.
5.

State True or False.
The Replace button replaces all the searched text with the new text, at once.
The Shift key is used to cancel the search.
The Picture option is present on the Home tab.
You cannot insert text in a Shape.
Watermark is a faded impression of an image which is placed behind the text in your
document.
6. The Borders and Shading button is present on the Page Layout tab.
(Ans. 1=True, 2=False, 3=False, 4=False, 5=True, 6=False)
C. Application based questions.
1. Aarushi wants to write a poem on „Rain‟ in the Word document. She wants to apply the
decorative text effect to every single line. Suggest her how she can apply the special text
effects.
2. The teacher has asked Vidhu to make a banner for „School fete‟. Which feature should he
use to add ready-made pictures into the document?
(Ans. 1. WordArt, 2. Clip Art)
D. Multiple choice questions.
1. Which shortcut key is used to open the Navigation pane to find the text?
a. Ctrl+F
b. Ctrl+H
c. Ctrl+S
2. When you insert a shape in a document, a new tab named __________ appears under the
Drawing Tools.
a. Home
b. Insert
c. Format
3. Which key is used to maintain the height and width ratio of a shape?
a. Shift
b. Ctrl
c. Alt
4. The WordArt button is present on the __________ tab.
a. Format
b. Home
c. Insert
5. Which among the following shortcut keys is used to open the Find and Replace dialog box?
a. Ctrl+F
b. Ctrl+H
c. Ctrl+S
(Ans. 1=a, 2=c, 3=a, 4=c, 5=b)

E. Answer the followings.
1. What do you understand by Clip Art?
Ans. Clip Art is a gallery of pre-designed pictures that can be inserted directly in a
document.
2. What is the use of WordArt feature?
Ans. The WordArt feature allows you to create special text effects. It gives unique look to the
text.
3. What is a Text box? How is it useful?
Ans. A Text Box is a placeholder where you can enter text. A text box can be used to give
new graphical effects. It can be moved anywhere along with its contents.
4. How can you insert a cover page in Word 2010?
Ans. Go to Insert tab in the Pages group and select Cover Page. Click on the desired cover
page layout and it will be applied to the document.
5. Explain the term Watermark?
Ans. Watermark can be defined as a dim or faded impression of an image or text on paper,
which is placed behind the text in a document.
Extra Questions.
Chapter – 1
1. Write down about Napier‟s Bones.
Ans. In 1617, John Napier made a calculating device – a set of rectangular rods called Napier‟s
Bones.
2. Write down about Andre tru‟o‟ng Trong Thi.
Ans. Andre Tru‟o‟ng Trong Thi is a Vietnamese-French engineer, considered to be the father of
the personal computer for creating the MICRAL(microcomputer) based on the Intel 8008
processor in 1973.
3. Write down about Lady Augusta Ada Lovelace.
Ans. Lady Augusta Ada Lovelace was an English mathematician and writer. She is considered
as the first programmer, who suggested binary data storage (0 and 1).
Chapter – 2
1. Write down about Vinod Dham.
Ans. Vinod Dham is considered as the father of Pentium for his role in the development of the
Pentium processor.
2. Write down about Rubinstein.
Ans. Seymour Rubinstein founded MicroPro International Inc. in 1978. MicroPro developed the
WordStar word processor software.
Chapter – 3
1. What is Line Spacing?

Ans. Line Spacing is the amount of space between the lines of text in a paragraph.
2. What is the use of Format Painter?
Ans. The Format Painter tool is used to copy and apply the same formatting such as font style,
size and color of a to another.
3. What is the use of Page Orientation property?
Ans. The Page Orientation property sets the printing direction of the text.
Chapter – 4
1. What is the use of Shapes?
Ans. The Shapes is a drawing feature that helps to add various shapes like stars, banners,
callouts, connectors, etc. to a document.

Annual Portion
Chapter – 5, Presentation Software – Special Effects
A. Fill in the blanks.
1. _________ means to create a mirror image of the selected shape or object.
2. _________ is a drawing feature that helps in inserting different shapes into a slide.
3. __________ is a placeholder where one can enter and manipulate the text.
4. __________ feature helps us to create special text effects.
5. __________ refers to the placement of text on a slide.
6. ____________ is an effective way to display data in the graphical and pictorial form.
(Ans. 1.Flipping, 2.Shapes, 3.Text Box, 4.WordArt, 5.Alignment, 6.Chart)
B. State True or False
1. The Ctrl + P key combination is used to print the slides of a presentation.
2. The Clip Art feature is used to add pictures in the slides.
3. Font Color option is present on the View tab.
4. You cannot select more than one object at a time.
5. Themes are sets of pre-designed formats.
6. A chart gets updated automatically with any changes in data.
(Ans. 1=True, 2=True, 3=False, 4=False, 5=True, 6=True)
C. Application Based Questions.
1. Meenakshi has created a presentation of six slides. The slides have the same background,
but she wants to change the background of each slide. Which option can help her in doing
so?

2. Aaryan‟s teacher has asked him to prepare a presentation on the topic “Save Environment”.
He has to type the content for the same, but does not know how to insert relevant pictures
into the slides. Suggest him the option in PowerPoint that he should use for the same.
3. Raj has created a presentation on the comparative analysis of rainfall for the past five years.
Which tool can he use to display data in a graphical form and analyze it in the best manner?
(Ans. 1.Themes, 2.Picture button on Insert Tab, 3.Chart)
D. Multiple Choice Questions.
1. Clip Art button is present on the _____________ tab.
a. View

b. Insert

c. Home

2. Which key helps you to select more than on shape at a time?
a. Shift

b. Ctrl

c. Escape

3. Which shortcut key combination is used to duplicate the slide?
a. Ctrl + P

b. Ctrl + E

c. Ctrl + D

4. Which among the following shortcut keys is used to open the Font dialog box?
a. Ctrl + F

b. Ctrl + T

c. Shift + T

5. Press the shortcut key _____________ to increase the font size
a. Ctrl + Shift + <

b. Ctrl + Shift + +

c. Ctrl + Shift + >

(Ans. 1=b, 2=a, 3=c, 4=b, 5=c)
E. Answer the followings.
1. What are the benefits of using Charts in a presentation?
Ans. Charts make it easier to show comparisons, growth, relationship among the values, and
trends in data. Charts provide an accurate analysis of the information.
2. Define the term Clip Art. How can you add a Clip Art in a Presentation?
Ans. Clip Art is used to add pictures to the slides to enhance its appearance and make it more
informative. To add Clip Art, Click on Insert tab. Click on Clip Art button. Select a picture and
click on insert button.
3. Briefly explain the WordArt feature.
Ans. The WordArt feature helps to create special text effects. It gives a unique look to the text. It
can make the text curved, wavy, shadowed, etc.
4. How will you rearrange the slides in a presentation?
Ans. Click on Slide Sorter View button of the View tab. Drag the slides to new location.
5. Which option enables you to change the background colour of the slide?
Ans. The Background Styles button, present in the Background group on the Design tab helps
to change the background color of the slide.
6. Define the term Alignment. In how many ways an alignment can be set?

Ans. Alignment refers to the placement of text on a slide. Alignment can be set in two ways,
vertical or horizontal.
Chapter – 6, Introduction to Scratch Programming
A. Fill in the blanks.
1. _____________ is one of the easiest computer languages.
2. A computer follows stepwise instructions to complete any task, which is known as ________
3. ________ is a graphic character which moves on the stage.
4. The blocks in the ________ block allow the Sprite to draw lines on the stage, change the
colour and thickness of lines.
5. In Scratch, the Sprite moves on the __________ when you run a program.
(Ans. 1.Scratch, 2.Program, 3.Sprite, 4.Pen, 5.Stage)
B. State True or False.
1. A computer understands the language that we speak.
2. Block Palette is the place where you can create a script for the Sprite to do a specific task.
3. A script consists of at least two blocks.
4. You can turn the Sprite only in clockwise direction.
5. Scratch 2.0 projects are saved with the extension .sb2
(Ans. 1.False, 2.True, 3.True, 4.False, 5.True)
C. Multiple Choice Questions.
1. Scratch 2.0 was officially released on ______________, 2013.
a. July 4

b. May 9

c. June 2

2. ___________ contains the set of blocks, which are used to program the Sprite.
a. Blocks Palette

b. Stage

c. Scripts Area

3. Who is the founder of Scratch?
a. James Gosling

b. Tim Berners Lee

c. Mitchel Resnick

4. In how many languages is Scratch available?
a. 40

b. 50

c. 60

(Ans. 1=b, 2=a, 3=c, 4=a)
D. Application based questions.
1. Aarav wants to make a Scratch project in which he wants to move the Sprite in the forward
direction by 20 steps. Suggest him the appropriate block to perform the action.
2. Shreya wants to change the thickness of the pen while drawing a trail behind the Sprite.
Suggest her the right block to be used.
(Ans. 1.Motion block, 2. Pen block)

E. Answer the followings.
1. What do you know about Scratch?
Ans. Scratch is a computer programming language that lets us to create our own interactive
stories, animations, games, music, and art. It provides an interactive environment to create a
program by dragging blocks of code.
2. Explain the term Sprite.
Ans. Sprite is a small graphic character that performs actions in a Scratch project.
3. What is the use of Pen block menu?
Ans. The blocks in the Pen block menu allow the Sprite to draw lines on the stage, change the
colour and thickness of lines.
4. What is the user of Sound block?
Ans. Sound block is used to add sound in a Scratch project.
5. What do you understand by Green Flag icon?
Ans. The Green Flag icon is placed at the top right corner of the stage screen. Clicking on the
green flag will run the script step by step.
6. Define program.
Ans. A program is also called software, which tells the computer what to do. Everything that a
computer does from starting up to shutting down is done by a program.
Chapter – 7, Internet Services
A. Fill in the blanks.
1. A __________ is a group of two or more computer systems linked together to form a global
network.
2. A __________ is a text based communication between one or more users.
3. __________ stands for Modulator Demodulator.
4. An ___________ is considered as most common way of Communication at workplace.
5. ________ can be defined as a set of rules that govern the acceptable online behaviour of
the user.
(Ans. 1.Network, 2.chat, 3.Modem, 4.Email, 5.Netiquette)
B. State True or False.
1. Internet does not support video calling.
2. A DSL uses 3-wire copper telephone line.
3. PC card modem is like the combination of external and internal modems.
4. The first online chat system was called Talkomatic.
5. Always use BCC messages while sending messages to multiple users.
(Ans. 1=False, 2=False, 3=True, 4=True, 5=True)

C. Application based questions.
1. Aarushi‟s children live in USA. She wants to talk to them face to face. Which Internet service
will you suggest her to use for the communication?
2. Mr. Verma wants to conduct a corporate meeting between all the branches of his company,
across the globe. He wants to have a face to face conversation with all the Regional
managers. Which Internet service should he use for this virtual meeting?
(Ans. 1.Video Conferencing, 2.Skype)
D. Multiple choice questions.
1. What does ISP stand for?
a. Internet Service Provider

b. Internet Source Provider

c. Internet System Provider

2. Google Hangouts is a free ____________
a. E-learning

b. E-banking

c. Chat Service Software

3. A strong ___________ consists of at least eight characters that are a combination of letters
in both uppercase and lowercase and special symbols.
a. Password

b. User-ID

c. Account_No

4. Name the device that connects a computer with the telephone line.
a. Mouse

b. Modem

c. Set Top Box

5. Which among the following is used to attach all kinds of devices to the computer?
a. USS

b. USB

c. UPS

(Ans. 1=a, 2=c, 3=a, 4=b, 5=b)
E. Answer the following.
1. What is Internet?
Ans. Internet stands for International Network. It is the largest computer network in the world,
connecting millions of computers.
2. What do you understand by the term Netiquette? Write any two e-mail netiquettes.
Ans. Netiquette can be defined as a set of rules that govern the acceptable online behaviour of
the user. Netiquette has come from two words – Net which means Internet and Etiquette which
means good manners.
3. Write a short note on video conferencing.
Ans. A video conferencing is a communication that involves exchanging audio and video at the
same time between people sitting at geographically different locations. The participants can
view each other on their monitors as well as hear voice over speakers.
4. Explain any two types of Internet connections.
Ans. Broadband connection – it uses wide bandwidth that provides high speed internet access
through various transmission mediums.

Writeless Connection – it uses radio frequency to connect to the internet and offers high speed
internet connection without any wire through wi-fi modem.
5. What is Modem? Name its types.
Ans. Modem stands for Modulator Demodulator. It is a device which allows a computer to send
and receive information through telephone lines by converting digital data into analog signal and
vice versa.
Extra Questions
1. What is the official website of Scratch?
Ans. The official website of Scratch is www.scratch.mit.edu.
2. In how many countries, is Scratch used?
Ans. Scratch is used in more than 150 countries.
3. Write down about Scratch 2.0
Ans. Scratch 2.0 provides a redesigned editor and allows you to edit projects directly from your
web browser as well as in an offline editor. It was officially released on May 9, 2013.
4. What is the use of Stop button in Scratch?
Ans. The Stop button is placed on the top right corner of the stage. It is red in color and is used
to stop the project at any time during execution.
5. What is ISP?
Ans. ISP stands for Internet Service Provider. It is a company that gives access to the Internet
in exchange for a fee. Examples of ISP are BSNL, Airtel, Jio, etc.
6. What is USB?
Ans. USB stands for Universal Serial Bus. USB port is a small rectangular port on the CPU used
to attach all kinds of devices like printer, keyboard, mouse, etc.
7. What is world wide web?
Ans. World Wide Web refers to a network of sites on the Internet, which contains information in
the form of text, pictures, animation, and videos. This information can be accessed by people all
over the world through internet.
8. What is web browser?
Ans. Web browser is a software that allows you to access the entire information available on the
web. Examples of web browsers are Google Chrome, Mozilla Firefox, Opera Mini, etc.
9. Distinguish between web page and website.
Ans. Information is put on the internet in the form of digital pages called web pages. These
pages may contain text, graphics, audio, video, etc. A website is a collection of related web
pages linked to one another.

